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Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

DANGER  
indicates that death or severe personal injury will result if proper precautions are not taken. 

WARNING  
indicates that death or severe personal injury may result if proper precautions are not taken. 

CAUTION  
indicates that minor personal injury can result if proper precautions are not taken. 

NOTICE  
indicates that property damage can result if proper precautions are not taken. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

WARNING  
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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Introduction 1
 

These instructions contain all the information you need for using the device.  

The instructions are aimed at persons mechanically installing the device, connecting it 
electrically, configuring the parameters and commissioning it, as well as service and 
maintenance engineers. 

 

Note 

It is the responsibility of the customer that the instructions and directions provided in the 
operating instructions are read, understood, and followed by the relevant personnel before 
installing the device. 

 

 

1.1 Items supplied 
 
 SITRANS FVA250 variable area flowmeter
 Operating Instructions 
 Calibration certificate (optional) 
 Test report 2.2 (optional) 
 Acceptance test (optional) 
 Stainless steel TAG plate (optional) 

1.2 Scope of delivery 

Inspection 
1. Check for mechanical damage due to possible improper handling during shipment. All 

claims for damage are to be made promptly to the carrier. 

2. Make sure the scope of delivery and the information on the nameplate correspond to the 
ordering information. 
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Identification 

 
① MEM specification Electrical specifications of the output / transducer (MEM) 
② Protection Protection class for the display housing 
③ TS Medium Maximum temperature of the medium 
④ PS Maximum pressure of the medium 
⑤ Material Material of the wetted parts 
⑥ Connection Connection type of the device 
⑦ Serial number Device specific serial number and the manufacturing year 
⑧ Code number Device specific code number 
⑨ PED specification Category acc. to Pressure Equipment Directive (PED) 

Figure 1-1 FVA250 nameplate example 

1.3 Transportation and storage 
To guarantee sufficient protection during transport and storage, observe the following: 

● Keep the original packaging for subsequent transportation. 

● Devices/replacement parts should be returned in their original packaging. 

● If the original packaging is no longer available, ensure that all shipments are properly 
packaged to provide sufficient protection during transport. Siemens cannot assume 
liability for any costs associated with transportation damages. 

●  
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CAUTION  

 
Insufficient protection during storage 

The packaging only provides limited protection against moisture and infiltration. 
 Provide additional packaging as necessary. 

● Store the device in a dry and dust-free place. 

● Keep away from direct sun and heat. 

● Avoid external load to the device. 

● The storage temperature range for standard devices with electrical components is -40 … 
+70 °C / -40 … +158 °F. 

1.4 History 
The contents of these instructions are regularly reviewed and corrections are included in 
subsequent editions. We welcome all suggestions for improvement.  

The following table shows the most important changes in the documentation compared to 
each previous edition. 

 
Edition Remarks 
02/2013 First edition 

Contents restructured 

 

1.5 Further Information 

Product information on the Internet    
The Operating Instructions are available on the CD-ROM shipped with the device, and on 
the Internet on the Siemens homepage, where further information on the range of SITRANS 
F flowmeters may also be found: 

Product information on the internet (http://www.siemens.com/flow)  

Worldwide contact person   
If you need more information or have particular problems not covered sufficiently by these 
Operating Instructions, get in touch with your contact person. You can find contact 
information for your local contact person on the Internet: 

Local contact person (http://www.automation.siemens.com/partner)  

http://www.siemens.com/flow
http://www.automation.siemens.com/partner
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CAUTION  
Correct, reliable operation of the product requires proper transport, storage, positioning and 
assembly as well as careful operation and maintenance. Only qualified personnel should 
install or operate this instrument.   

 

 Note 

Alterations to the product, including opening or improper modifications of the product, are not 
permitted. 

If this requirement is not observed, the CE mark and the manufacturer's warranty will expire.
 

2.1 Hot surfaces resulting from hot process media 
 

CAUTION  
Hot surfaces resulting from hot process media 

Danger of burns resulting from surface temperatures above 70 °C (155 °F).  
 Take appropriate protective measures, for example contact protection. 
 Make sure that protective measures do not cause the maximum permissible ambient 

temperature to be exceeded, see Technical data (Page 51), "Temperatures". 
 

2.2 Laws and directives 

General requirements  
Installation of the equipment must comply with national regulations. For example EN 60079-
14 for the European Community. 
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Instrument safety standards  
The device has been tested at the factory, based on the safety requirements. In order to 
maintain this condition over the expected life of the device, the requirements described in 
these Operating Instructions must be observed. 

 

NOTICE  
Material compatibility  

Siemens Flow Instruments can provide assistance with the selection of wetted sensor 
parts. However, the full responsibility for the selection rests with the customer and Siemens 
Flow Instruments can take no responsibility for any failure due to material incompatibility. 

The manufacturer is not liable for any damage resulting from improper or intended use of 
these devices. 

 

CE-marked equipment 
The CE mark symbolizes the compliance of the device with the following directives: 

● EMC-directive 2004/108/EC and 89/336/EWG 

● Low voltage directive 2006/95/EC 

● Pressure equipment directive (PED/DGRL) 97/23/EC 

● ATEX directive 94/9/EG 

Compliance to EN 13463-1 / EN 50014 
In its basic design, this flow metering device is a non-electrical device without its own ignition 
sources. The device complies with the requirements of EN 13463-1.  

The equipment is evaluated as an electrical assembly when electrical signal transducers are 
installed. In this case the entire equipment including the installed electrical signal 
transducers complies with EN 50014. 

The electrical and thermal data and the special directives of the EC Type Examination 
Certificate with regard to the installed signal transducers must be observed and adhered to.  

See also 
Classification according to pressure equipment directive (PED 97/23/EC) (Page 52) 
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2.3 Installation in hazardous area 
 

WARNING  
Equipment used in hazardous areas must be Ex-approved and marked accordingly. It is 
required that the special conditions for safe use provided in the manual and in the Ex 
certificate are followed! 

 

Hazardous area approvals  
The device is approved for use in hazardous area zone 1 and has the following approval: 

● II 2 GD c 

Designation in case of installed limiting value transmitter SJ 3.5-N: 

● II 2G EEx ia IIC T6-T4 

Designation in case of installed magneto electrical measuring transducers HART and 
PROFIBUS:  

● II 2G EEx ia IIC T6 

WARNING  
 

Make sure the hazardous area approval is suitable for the environment in which the 
device will be installed. 

Intrinsically safe data 
In accordance with the tables contained in the EC Type Examination Certificate PTB 99 
ATEX 2219 X, the inductive sensor SJ 3.5-N must be operated within the temperature class 
T5 with an intrinsically safe circuit that does not exceed the maximum values of a Type 3 
circuit. 

Table 2- 1 Intrinsically safe circuits  

Intrinsically safe 
circuits 

Type 1 Type 2 Type 3 Type 4 

Ui 16 V 16 V 16 V 16 V 
Ci 50 nF 50 nF 50 nF 50 nF 
Li 250 μH 250 μH 250 μH 250 μH 
Ii  25 mA 25 mA 52 mA 76 mA 
Pi [mW] 34 mW 64 mW 169 mW 242 mW 
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WARNING  
With intrinsically safe circuits, use only certified sensors appropriate for the transmitter. 

If a non-conforming supply unit is used, the "fail-safe" type of protection will no longer be 
effective and the approval certification will be invalid. 

 

Temperature specifications for Ex use  

Table 2- 2 Maximum ambient temperature (Ta) 

Temperature class Type 1 Type 2 Type 3 Type 4 
T6 73 °C 66 °C 45 °C 30 °C 
T5 88 °C 81 °C 60 °C 45 °C 
T4 100 °C 100 °C 89 °C 74 °C 

 

 

Note  
Temperature specification 

For further temperature specification, see Technical data (Page 51), "Temperatures".  
 

Ambient temperature factors 
The impact of the process media temperature on the installed signal transducers must be 
taken into account. 

For this purpose the temperature rise of the maximum process media temperature in relation 
to the maximum ambient temperature and the appropriate factor defined in the following 
table must be taken into consideration. 

Table 2- 3 Ambient temperature factors 

Nominal width Factor (standard model) Factor (advanced display) 
DN15 and DN25 0.2 0.07 
DN40 and DN50 0.25 0.085 
DN80 and DN100 0.3 0.1 

Example 1 
Example of calculation of the ambient temperature at limiting value transmitter (limit switch 
SJ 3.5-N) for sizes DN 15 and DN 25. 

● Max. ambient temperature: Tamb = 40 °C 

● Max. process media temperature: Tm = 120 °C 
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● Factor for heat input: F = 0.2 

● Temperature class: T4 

● Te = excess temperature 

● Ta = ambient temperature at limiting value transmitter (limit switch SJ 3.5-N) 

 
Te = Tm − Tamb = 120°C − 40°C = 80°C  
Ta = (Te* F) + Tamb = (80°C* 0,2) + 40°C = 56°C  
Figure 2-1 Calculation of ambient temperature at limiting value transmitter (limit switch SJ 3.5-N) 

Example 2 
Example of the calculation of the max. process media temperature in relation to the max. 
ambient temperature for the installed sensor type at widths for sizes DN 15 and DN 25 

● Ta = 70 °C 

● Tamb = 60 °C 

● F = 0.2 

Tm = (Ta – Tamb) + Tamb = (70°C – 60°C) + 60°C = 110°C
0.2F

 
Figure 2-2 Calculation of max. process media temperature 

Special conditions for safe use  
The maximum surface temperature of the measuring substance is decisive as the equipment 
does not exhibit its own energy sources that could lead to a rise in temperature. 

Regular cleaning is essential when the equipment is employed in dust-explosive zones in 
order to prevent sedimentation exceeding the thickness of 5 mm. 

It is required that: 

● Electrical connections are in accordance with EN 60079-14 (Installing Electrical Systems 
in Explosion Hazardous Areas). 

● The protective cover over the power supply is properly installed. For intrinsically safe 
circuits the connection area can be opened. 

● Appropriate cable connectors are used for the output circuits: 

– Intrinsically safe: blue 

– Non-intrinsically safe: black 

● Sensor and transmitter are connected to the potential equalization.  
For intrinsically safe output circuits potential equalization must be maintained along the 
entire connection path. 

● Sensor insulation thickness is max. 100 mm (only insulated sensors). 
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● EN 50281-1-2 is considered for installation in areas with combustible dust. 

● When protective earth (PE) is connected, no potential difference between the protective 
earth (PE) and the potential equalization (PA) can exist, even during a fault condition. 

WARNING  
 

"Flameproof enclosure" type of protection 

Only open devices with protectiontype "Flameproof enclosure" in hazardous areas when 
the power to the device is turned off, otherwise there is a risk of explosion. 

WARNING  
 

Laying of cables 

Cable for use in zone 1 and 2 or 21 and 22 must satisfy the requirements for having a 
proof voltage < 500 V AC applied between the conductor/ground, conductor/shield and 
shield/ground. 

Connect the devices that are operated in hazardous areas as per the stipulations 
applicable in the country of operation, e.g. for Ex "d" and "nA", permanent cables must 
be laid. 

2.4 Certificates 
Certificates are posted on the Internet and on the documentation CD-ROM shipped with the 
device. 

See also 
Certificates on the Internet (http://www.siemens.com/processinstrumentation/certificates) 

http://www.siemens.com/processinstrumentation/certificates


 

3Description 

 

The SITRANS FVA250 is suitable for multipurpose measuring of fluids and gases in closed 
piping systems.  

The robust design also permits application under harsh conditions.  

Different flange connections, liners and rotameter materials meet the requirements in the 
pharmaceutical and chemical industry.  

3.1 System components 
● SITRANS FVA250 fitting 

● Float (optional with damping piston) 

● Gas damping (optional) 

● Indicator unit (incl. bearing unit, scale, scale pointer) 

● MEM transducer with HART / PROFIBUS protocol (optional) 

● Limiting value transmitter(s) (optional) 

 
Figure 3-1 Variable area flowmeter 
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Magneto-electrical measurement transducers (MEM) 
SITRANS FVA250 is optionally available with magneto-electrical measurement transducers 
for configuration with HART (MEM) or with PROFIBUS PA (MEM-PPA). 

 
Figure 3-2 Magneto-electrical measurement transducer (MEM) 

3.2 Design 
SITRANS FVA250 is an all-metal variable area flowmeter with a standard length of 250 mm 
(9.84 inch). The momentary flowrate is indicated in volume or mass per time unit. The 
measured value is indicated directly on the scale.  

The equipment can be supplied with accessory electrical components and touch-sensitive 
switches for process monitoring and control. 

Features  
● Standard model can be supplied at short notice 

● Robust all-metal fitting with shock-proof housing 

● Applicable for the measurement of aggressive and combustible materials 

● Applicable for high pressures and temperatures 

● Product and percentage scale 

● Optionally supplied with heating and cooling jackets fitted 

● Contamination-resistant design 

MEM transducers 
The measuring transducers MEM / MEM-PPA are installed in the flowmeter FVA250. In this 
manner the range of volume flow measurement is covered.  

The measuring transducers MEM / MEM-PPA are designed for installation in a housing that 
is at least compliant with enclosure rating IP20. 
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3.3 Theory of operation 
The FVA250 operates according to the principle of flotation. The flowing measuring 
substance raises the conical float in the measuring ring. In this way the annular gap widens 
until an equilibrium between the buoyancy of the measuring substance and the weight of the 
float is achieved. The height achieved by the float is directly proportional to the flowrate. The 
movement of the float is transmitted via a magnet to a subsequent magnet in the display part 
outside the measuring pipe.  

90
° -

 13

0°

 
Figure 3-3 Measuring cone / scale angle 

MEM transducers 
The setting of the float is transmitted to the pointer axis by means of a magnetic system on 
the pointer axis. The measuring transducers MEM / MEM-PPA measures the field of a 
magnet mounted to the pointer axis. The scale, which is generally non-linear, is linearized 
with a maximum of 16 interpolation points in the process. 

● The MEM transducer (HART) generates a resulting output current 4...20 mA.  
The earth magnetic field and homogeneous external magnetic fields, if not too high, are 
more or less compensated by the differential measurement. 

● The MEM transducer (HART) provides limit switches and a pulse output. The pulses are 
displayed at binary output N1. It must be observed that the maximum pulse output rate 
amounts to approximately 10 Hz. The pulse width is approximately 50 ms. 

● The MEM-PPA transducer (PROFIBUS PA) generates a digitalized measured value. 
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4Installing/Mounting 

 

SITRANS F flowmeters with minimum IP65/NEMA 4X enclosure rating are suitable for indoor 
and outdoor installations. 

● Make sure that pressure and temperature specifications indicated on the device 
nameplate / label will not be exceeded.  

 

WARNING  
Installation in hazardous location 

Special requirements apply to the location and interconnection of sensor and transmitter. 
See "Installation in hazardous area" (Page 11)  

 

 

CAUTION  
Aggressive atmospheres 

Damage to device through penetration of aggressive vapors. 
 Ensure that the device is suitable for the application. 

 

4.1 Installation safety precautions 
 

WARNING  
High pressure hazard 

In applications with working pressures/media that can be dangerous to people, 
surroundings, equipment or others in case of pipe fracture, we recommend that special 
precautions such as special placement, shielding or installation of a pressure guard or a 
safety valve are taken when the sensor is mounted.     
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4.2 Device check 
Prior to installation check the functionality of the device:   

● Remove the transport protection from the fitting. 

● Verify the free mobility of the float. 

– The float must slide smoothly in the pipe without canting or deadlocking. 

– The pointer must smoothly follow the movement of the float. 

– In the idle state (no flow) the pointer must be at the marked reference point (first line 
on the scale). 

– At the end position of the float the pointer must be above the final value of the scale. 

4.3 Determining a location 
Ensure that there is sufficient clearance to magnet-influencing parts, such as for example 
solenoid valves and ferromagnetic components, e.g. steel brackets/structures. 

Clearance between adjacently mounted devices 
Observe at least 300 mm (11.8") as the lateral clearance between 2 adjacently mounted 
instruments. 

The instruments can be mounted staggered by the length of one instrument at reduced 
clearance.  

Clearance to influencing steel parts 
The lateral clearance to influencing steel parts must constitute at least 200 mm. In case of 
doubt the influence can be tested by moving the instrument up and down approximately 
200 mm (7.87") at a selected clearance and verifying whether the position of the pointer in 
the display changes.  

Inlet / outlet conditions 
● Inlet and outlet pluggings in front of and behind the instrument are usually unnecessary in 

the case of linear flow profile of the medium. 

● Avoid installation of unilaterally constricting fittings in front of the instrument. 

● As a rule, interference-free inlet and outlet tracks are not required. In the case of highly 
asymmetric flow profiles, however, additional measures (e.g. inlet tracks, flow rectifiers) 
could be expedient for the attainment of measuring accuracy.  
If this is absolutely necessary, at least the length of the instrument = 250 mm (9.84") 
should be designed as the inlet track. 

● The nominal width of the pipe to be connected must correspond to the nominal width of 
the measuring instrument. 

● For gases, valves must be installed in the outlet of the measuring device. 
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4.4 Mounting the sensor 

Before mounting 
● Verify that accessories such as spring stop, gas/fluid damping are still correctly seated in 

the flange. 

● Check that the installation clearance between the flanges of the pipe correspond to the 
fitting dimension of the instrument and additionally 2 gaskets. 

 

 

Mounting the device 
● Install the device vertically. 

● Ensure that the values displayed on the scale are visible and readable. 

● Ensure adequate space for a potential upgrading of the instrument. 
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● Align the flanges in order to achieve an installation free from strain. 

● Use mounting screws and gaskets of the prescribed dimensions. The gaskets must be 
appropriate for the operating pressure, the temperature and the process media. 

CAUTION  

 
PTFE-lined devices 

For PTFE-lined instruments, use gaskets where the inner and outer dimensions conform 
with the raised face of the device. 

● Tighten the screws crosswise so that the process connections are sealed. The tightening 
torque for the screws must be adhered to especially in the case of PTFE-lined devices.  
The flange screws for PTFE-lined fittings may only be tightened with the following 
maximum torques (VDI/VDE Guideline 3513): 

– DN 15 to 25 (½" to 1"): 14 Nm 

– DN 50 (2"): 25 Nm 

– DN 80 (3"): 35 Nm 

– DN 100 (4"): 42 Nm. 

● Ensure that the pipe has been mounted securely enough to exclude any vibration or 
oscillation. 

● Do not use steel mounting brackets on the instrument! 

Gas applications 
Pay particular attention to the positioning of the valve when gas is to be measured. If the 
instrument is absolutely calibrated for a pressure exceeding 1.013 bar, the valve is usually 
installed in the outlet of the flowmeter.  

In order to prevent compression oscillation during gas measurements, a throttle must be 
arranged immediately behind the measuring instrument. In order to avoid erroneous 
measurements, the arrangement must be selected to ensure that the pressure prevailing in 
the measuring instrument corresponds to the reference pressure of the calibration. 

4.5 Damping 
Variable area flowmeter damping is recommended:  

● In general during the measurement of gas 

● If air bubbles in the medium cannot be avoided 

● If shock pressure predominates in the pipes, arising through a delay in the flow, e.g. due 
to rapid throttling or shut-off 

● If turbulence, pulsations or any other type of instability in the variable area flowmeter 
could lead to vibration 

● If the flow pressure cannot be built up slowly 

● If vibrations in the line cannot be avoided 
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Installation and dismounting of the cone/float/damper/spring stop 
The instrument must be dismounted from the pipe before the float can be removed. After 
dismounting, clamp the instrument in a horizontal position, ensuring that the fitting is not 
damaged in the process. The dismounting procedure depends on the variable area 
flowmeter model. 

Model with measuring ring: 

● Prevent the float (1) from torsion by fixing the upper guide bracket (2) by 
using a suitable tool. 

● Remove from below the screw in the instrument from the guide bracket and then remove 
the guide bracket. 

● Remove the self-locking nut (3) which fixes the lower guide bracket (4) and take the guide 
bracket out of the instrument. 

● Take the float out of the measuring unit upwards. 

● Insert the new float into the instrument from the top. While doing so carefully put the 
bottom end of the float through the measuring ring. 

● Insert the lower guide bracket at the bottom end of the float and fix it with the self-locking 
nut. 

 
Figure 4-1 Replacing floats 

 

① Float 

② Upper guide bracket 

③ Self-locking nut 

④ Lower guide bracket 
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Model with cone: 

Replacing floats for devices with cone (standard measuring ranges up to 5-50 l/h (gases: 
0.15 – 1.5 m³/h) cannot be executed by the customer. For this purpose the device has to be 
returned to the manufacturer. For details refer to "Return procedures" (Page 49). 

 

NOTICE  
Use of unsuitable tools 

Danger of device damage through use of unsuitable tools 
 Avoid damaging the float/measuring ring and cone. 

 

Important 
After the replacement of the float a recalibration of the flowmeter is highly recommended, 
otherwise the measurement accuracy cannot be ensured. 

4.6 Retrofitting MEM transducers 
Retrofitting of a MEM / MEM-PPA in a fitting that has been installed is only conditionally 
possible.  

If the fitting is calibrated with a pointer axis that does not yet bear a measuring magnet, the 
scale must be recalibrated. The reason for this measure is the reaction of the supplementary 
measuring magnet on the float magnet. 



 

Connecting 5
5.1 Wiring MEM / MEM-PPA 

To connect the magneto-electrical measuring transducer proceed as follows: 

1. Remove display cover. 

2. Insert cable set via cable gland. 

3. Guide signal leads under MEM / MEM-PPA from cable gland to terminal block of 
magneto-electrical measuring transducer. 

4. Connect the device according to applicable electrical schematic: 

– Magneto-electrical measuring transducer HART (Page 27) 

– Measuring transducer HART with 4-20 mA output, pulse output and one limit switch 
(Page 28) 

– Measuring transducer HART with 4-20 mA output and two limit switches (Page 29) 

– Magneto-electrical measuring transducer MEM-PPA (Page 30) 

5. Tighten cable gland. 

6. Remount display cover. 

7. Seal tightly. 

CAUTION  

 
Non-observance of polarity 

Observe the specified polarity requirements. Non-observance of polarity may damage 
the device. 
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5.2 Electrical connection schematics 

5.2.1 Limit switches 

 
Figure 5-1 Terminal diagram for inductive limit switches 

 

 
Figure 5-2 Terminals - one limit switch 
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Figure 5-3 Terminals - two limit switches 

5.2.2 Magneto-electrical measuring transducer HART 

 
Figure 5-4 Terminal diagram for magneto-electrical measuring transducer HART 
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Figure 5-5 Terminals - transducer MEM with 4-20 mA output 

Table 5- 1 Supply current data (EEx ia IIC T6) 

Li 240 μH Ui 30 V 
Ci 16 nF Ii 150 mA 
Ta 70°C Pi 1000 mW 

5.2.3 Measuring transducer HART with 4-20 mA output, pulse output and one limit 
switch 

 
Figure 5-6 Terminal diagram for measuring transducer HART with 4-20 mA output, limit switch and 

pulse output 
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Figure 5-7 Terminals - transducer MEM with 4-20mA output and binary outputs 

Table 5- 2 Supply current data (EEx ia IIC T6) 

Li 240 μH Ui 3 0V 
Ci 16 nF Ii 150 mA 
Ta 70°C Pi 1000 mW 

 

Table 5- 3 Binary outputs (EEx ia IIC T6) 

Li 4 μH Ui 30 V 
Ci 16 nF Ii 20 mA 
Ta 70°C Pi 100 mW 

5.2.4 Measuring transducer HART with 4-20 mA output and two limit switches 

 
Figure 5-8 Terminal diagram for measuring transducer HART with 4–20 mA output and two limit 

contacts 
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Figure 5-9 Terminals - transducer MEM with 4-20 mA output and binary outputs 

Table 5- 4 Supply current data (EEx ia IIC T6) 

Li 240 μH Ui 30 V 
Ci 16 nF Ii 150 mA 
Ta 70°C Pi 1000 mW 

 

Table 5- 5 Binary outputs (EEx ia IIC T6) 

Li 4 μH Ui 30 V 
Ci 16 nF Ii 20 mA 
Ta 70°C Pi 100 mW 

5.2.5 Magneto-electrical measuring transducer MEM-PPA 

 
Figure 5-10 Terminal diagram for measuring transducer MEM-PPA 
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Figure 5-11 Terminals - transducer MEM-PPA 

Table 5- 6 Supply current data (EEx ia IIC T6) 

Li 10 μH Ui 25 V 
Ci 5 nF Ii 280 mA 
Ta 70°C Pi 2000 mW 
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Commissioning 6
 

When starting up the device, the following points must be observed: 
● Ensure that the actual operation conditions (pressure, temperature) do not exceed the 

limits which are given on the nameplate of the device 

● Avoid float impacts! 

Therefore it is recommended to start up with a closed shut-off valve and open it 
slowly. Particularly the use of solenoid valves is not recommended. 

● When measuring liquids, the pipes must be vent slowly to prevent shock pressure 
due to gas bubbles. 

● When measuring gases, the pressure must be increased slowly in order to prevent 
high shock pressure. 

● During the start-up of new systems, residual materials are conveyed in the medium 
and could adhere to the float. In this case we recommend cleaning the instrument 
after a relatively short period of operation. 

● When operating the flowmeter at low flowrates, the device has to start-up with a 
high flowrate to allow the float to level out. This will ensure measurements within 
the specified accuracy class. 

6.1 Analogue output (MEM) 
The magneto-electrical measuring transducer (MEM) is completely factory-set when it is 
delivered to the customer. 
After applying the supply voltage to the device, the current output will be 3.5 mA to 4 mA for 
a few seconds. After that a current corresponding to the pointer deflection will flow. 

 

Note  
Correct current output 

Due to the influence of the float magnet, the MEM transmitter will only output the correct 
current if the pointer position is caused by the float. Turning the pointer manually will cause 
incorrect values, but it is suitable for testing the unit. 
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6.2 Limit signal settings 

Limit switches (inductive contact) 
The limit switches can be set over the entire measuring range by varying the position of the 
limit pointers. 

 

CAUTION  
Unless otherwise desired by the customer, the factory set value for the switching point is for 
version with one limit switch about 40% of URV (Upper Range Value) and for devices with 
two limit switches about 20%/80% of URV. 

 
 

To set the limit switches at the desired position, observe the following steps: 

1. Loosen the two fixing screws ② before moving the pointer ①. 

2. Move the pointer to the desired position. 

3. Tighten the screws to fix the pointer. 

 
Figure 6-1 Adjustment of the switching point (limit switch) 

CAUTION  

 
The applied limit switches SJ 3.5 N are normally closed contacts according to NAMUR 
recommendation NE21. The desired switching function of the limit switch must be 
realized by the relay contact of the external isolation amplifier (changeover contact). 
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6.3 Output settings 

6.3.1 Measuring transducer HART with 4-20 mA output / pulse output / limit switches 
The magneto-electrical measuring transducer has already been calibrated with regard to the 
scale values by the manufacturer when it is delivered to the customer.  

The HART version can only be supplied with a 2-conductor 4-20 mA connection signal 
output. The signal output and the limits can be configured using a HART modem with the 
configuration program "SIMATIC PDM" from Siemens. 

6.3.2 Measuring transducer PROFIBUS 
The PROFIBUS PA is designed with an interface to provide a digital communication electric 
circuit in compliance with the FISCO model.  

The configuration tool for the signal output is "SIMATIC PDM" from Siemens. 

6.4 Configuring with HART 

6.4.1 Commissioning with PDM 
SIMATIC PDM (Process Device Manager) is a software package for configuring, 
parameterizing, commissioning and maintaining field devices (e.g. transducers).    

Among other features, SIMATIC PDM contains a simple process for monitoring process 
values, interrupts and status/diagnosis signals of a field device. 

 

 Note 

For instructions on installation and operation of SIMATIC PDM, refer to the SIMATIC PDM 
Getting Started (included in the documentation package that comes with PDM) 

 

Setting up the connection to the field unit 
For the creation of the communication between the field unit and the PC a corresponding 
project must first be defined in the SIMATIC Manager.  

The structure of the communication network is defined here. This consists of the field unit 
with integrated HART interface and a PC with a connected HART modem. 

Adding the device to the Network 
1. Add PC to SIMATIC communication network:  
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– Select "File" → "New". 

– Right-click on "Net" and select "Insert New Object" → "PC". 
Your PC is now added to the Communication Net. 

– Right-click on "PC" and select "SIMATIC PDM" → "Define current PC" in order to 
allocate the PC. 

2. Set up the communication parameters for SIMATIC communication network: 

– Right-click on "PC" and select "Insert New Object" → "COM interface". 

– Right-click on "COM interface" and select: "Object properties" → "Connection". 

– Enter the number of the COM Port. 

3. Add HART modem to SIMATIC communication network: 

– Right-click on "Net" and select "Insert New Object" → "HART modem". 

– Right-click on "HART modem" and select: "Object properties" → "Connection". 

– Select the Master Type "Secondary". 

4. Add the field unit to the SIMATIC communication network: 

– Right-click on "HART modem" and select: "Insert new object" → "HART device". 

– Type in a name for the field unit, e.g. FVA250. 

– Make sure that the field unit address is set to 0. 

– Click on "Assign" and assign the device to MEM (Sensors→Flow→Variable 
Area→SIEMENS→MEM) and click "OK". 

6.4.2 Basic parameter settings 

Read all parameters 
Before any parameterization is carried out all parameters must be read from the device into 
the offline table of SIMATIC PDM. This is necessary because the offline table merely 
contains default data. 

1. Open the PDM device driver. 

2. Select "Device" → "Upload to PC/PG". 

3. Select "Execute even if the device TAG does not match the project data TAG" and click 
"OK" to read all parameters to the offline table.  
After closing the dialog all loaded parameters should show "Loaded" in the status of the 
PDM table. 

Setting basic parameters 
Parameters that can be set by the user are categorically highlighted in white – whereas the 
remaining attributes are protected and highlighted in gray. 

1. Configure basic parameters. 
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2. Select: "Device->Download to device". 

3. Select "Execute even if the device TAG does not match the project data TAG" and click 
"OK". 

6.4.3 HART parameters 
The available parameters are grouped into the following blocks: 

Identification 
General information on devices that enable the clear definition of the device is deposited in 
this parameter block.  

 
The following parameters can be deposited: 

● TAG 

● Description 

● Date 

● Message 

● Works number 

Basic settings 
The time response of the MEM is set in this parameter block. 

● Damping 
A time constant within the range of 0 to 60 seconds can be selected via these 
parameters. On expiry of this time the measured value reaches 63.7% of the final 
condition with an abrupt change of the input signal. 
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Input 
All parameters that are involved in the acceptance of the measured value in the MEM are 
included in this block. 

● Unit 
The unit of the measured variable is defined via this parameter. The following units are 
available: 

– m3/h, m3/min, m3/s 

– l/h, l/min, l/s 

– USgal/h, USgal/min, USgal/s 

– IMPgal/h, IMPgal /min, IMPgal /s 

– kg/h 

– t/h 

– g/h 
 

  Note 
Change of unit 

In case of alteration of the unit no conversion of the measured value or the upper 
range value is conducted. 

● MIN/MAX 
These two parameters define the maximum and the minimum limits of the relative 
flowrate. 
The falling short of or exceeding of MIN/MAX can be transmitted as an alarm at power 
output (see description of self-test) as well as via the binary outputs (see description of 
outputs) 

● Final value 
This parameter (in HART known as "URV") serves the adaptation of the power output to 
the measuring range (20 mA = 100%).  
The initial value of the measuring range (in HART known as "LRV" (lower range value)) is 
not supported by the MEM and is reset to zero. 

● Leak flow volume 
This parameter is a percent value and determines a minimum flowrate value (in relation 
to the final value). Below the leak flow volume, the measured value is reset to zero. 
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Outputs 
This block comprises all parameters that define the behavior of the current output and the 
binary outputs. 

● Power output – power in case of alarm 
An alarm status of the MEM (see description of self-test) can optionally be displayed at 
the current output. The possible current settings are: 

– >20.5 mA (typically 21.6 mA) 

– <3.8 mA (typically 3.6 mA) 

– unused 

● NAMUR switch – function 
The binary outputs N1 and N2 (NAMUR switch) are constructed as optocouplers with 
downstream transistor and comply with the industrial standard EN 60947-6-6:2000.  
The functions of the outputs are controlled by the microprocessor and may comprise the 
following functions: 

 
N1  N2 
MAX MIN 
Pulse output MIN 
Pulse output MAX 
Pulse output MIN/MAX 

 
 

 Note 
Parameters MIN and MAX 

The parameters MIN and MAX are the limits of relative flow defined in the parameter block 
Input. 

 

● NAMUR switch – activated state 
The activated status of the NAMUR switches N1 and N2 is set via this parameter.  
The options are: 

– closed 

– open 

 

 Note 
Activated state 

The set active status also applies to N1 if this is configured as a pulse output. 
 

Totalizer (pulse output) 
Both the totalizer and the pulse output measures volume and measuring units. 
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The dimension unit of the totalizer pursues that of the flow rate (e.g. if the flow rate unit is l/h, 
the totalizer will measure in liters). 

Pulses are optionally displayed at binary output N1. It must be observed that the maximum 
impulse rate amounts to approx. 10 Hz. The pulse width is approx. 50 ms.  

● Totalizer  
The totalizer function of the MEM can be switched ON or OFF via this parameter. 
The totalizer value is saved in the EEPROM when the instrument is switched off. The 
totalizer can be reset via a HART command. 

Self test 
The MEM possesses various self-test functions for continuous monitoring of the current 
measuring values, which may be used to trigger an alarm in case of error. 

● Self-test mask 
The MEM self-test possesses the following function range, whereby each control function 
can be individually switched ON and OFF: 

– Q > 103% (rel. flowrate > 103%) 

– Q <> Sensor limits (rel. flowrate outside the sensor limit) 

– Sensors too hot/too cold (temperature in device too high/too low) 

– A-B unreasonable (sensor signals implausible) 

– Meter overflow 

– MIN/MAX-limit (shortfalling MIN or exceeding MAX) 

The incidence of a self-test error is signaled under HART in status and, if necessary, 
transmitted as an alarm on the current output. 

6.5 Configuring with PROFIBUS PA 

6.5.1 Magneto-electrical measuring transducer MEM-PPA 

PROFIBUS- PA- interface 
PROFIBUS- PA divides the parameters that are important for configuring the device in the 
system into function blocks. These parameters can only be accessed acyclically. The 
function and assignment of these blocks were defined by the PROFIBUS User Organization 
(PNO) in the "Profile for process control devices Rev. 2.0, Class B". 

The transmitter MEM-PPA exclusively uses Profile 3 area flowmeters, because Profile 2 
does not apply to area flowmeters. 

The "Physical Block" includes information about the device (e.g. type, profile and 
manufacturer). 
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The "Transducer Block" contains transmitter-specific parameters (e.g. calibration factor, zero 
point and nominal size). 

The analog input "Function Block" contains the parameters for forming the output value (e.g. 
limit values, measuring range and time constant). The output value of this block (OUT) can 
also be accessed cyclically. 

 
Figure 6-2 Block model of the MEM with PROFIBUS-PA 

 

GSD File 

This file is needed for the integration of the device into the PROFIBUS- PA network and will 
be copied into the subdirectory defined by the programmable controller software. 

The GSD file can be downloaded from the Siemens homepage (Support-Center). 

Name of file: PA139700.GSD 

Device address 

The device address is used for selecting the device in the system. 

This address may only be assigned once. Note that devices with identical addresses will 
collide during bus access. 

The device address can only be set via the bus. When the device is shipped from the 
factory, the preset address is 126. 

Before commissioning the system, every new device must be assigned a new, unassigned 
address (<126). 



Commissioning  
6.5 Configuring with PROFIBUS PA 

 SITRANS FVA250 
42 Operating Instructions, 02/2013, A5E03821131-01 

Cyclic communication 

The master can cyclically read out the "OUT" measured value from the MEM-PPA 
transmitter. The measured value is represented as a 32-bit floating-point number in 
accordance with IEEE-754; the corresponding status is represented as an 8-bit word. The 
unit of the measured value can be selected (see Acyclic communication/unit of measured 
value). 

Assigning a meaning to the status word 

The meaning of the status messages has been defined by the PROFIBUS User Organization 
(PNO). 

The device reports the following states: 

 
Hex Meaning Quality of the 

measuring value 
Condition 

0x8A Exceeding 
HI-LIM 

Good Measured value exceeding warning value 

0x89 Shortfalling LO-LIM Good Measured value is falling below warning value 
0x8E Exceeding 

HI-HI-LIM 
Good Measured value exceeding alarm value 

0x8D Shortfalling  
LO-LO-LIM 

Good Measured value falling below alarm value. 

0x52 Exceeding upper Uncertain, measured 
value is inaccurate 

Sensor limit exceeding limit value 

0x51 Falling below lower Uncertain, measured 
value is inaccurate 

Sensor limit falling below limit value 

6.5.2 Acyclic communication 

Parameters of the Transducer Block 
Set Zero 

The zero point can be changed manually. The zero point parameter is set in the unit of 
flow/level/density and is continuously subtracted from the uncorrected measured value. 

Calibration factor 

The measured value is multiplied by the calibration factor. This factor is 1 when the device is 
shipped from the factory. The following formula is used: 

Flow rate = (uncorr. flow rate – zero point) ▪ calibration factor 

Low-flow cutoff 

The unit of the low-flow cutoff is identical to the unit of the flow rate. At level/density 
applications this parameter should be set to zero. If the flow drops below the low-flow cutoff, 
the measured value will be set to zero. Hysteresis is 3%, with an unilateral effect. 
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Flow direction 

The flow direction can be indicated by a sign. If the sign is negative, reverse flow turns into 
forward flow. 

Device mode 

The MEM-PPA measures unidirectional (only forward flow). 

Filter type (Information field) 

Normal, strong.  

Nominal size 

The nominal size is factory-set as appropriate for the corresponding flowmeter sensor. The 
unit is inch. The maximum allowable diameter setting is 4". 

The upper and the lower sensor limit 

This parameter defines the upper range value. The unit is identical to flowrate/level/density 
unit. If the upper range value limits are exceeded, an alarm will be generated. 

Self-test 

The MEM-PPA self-test can be activated (=1) or switched of (=0). The existence of an error 
is displayed in the OUT state. 

Units of measured value 

The measured value of the flow rate/level/density can be acyclically read from the transducer 
block. The following units are available: 

m3/h 

m3/min 

l/h 

l/min 

USGal/h 

USGal/min 

IMPGal/h 

IMPGal/min 

t/h 

kg/h 

g/h 

Changing the unit does not automatically adjust the measuring range value! 

Parameters of the Analogous Input Function Block 
Filter time constant 

Between 0 to 60 seconds, are used for damping the measured value. Damping is carried out 
during measured-value acquisition. 
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Simulation 

Instead of the measured value and the status from the Transducer Block, a simulation value 
and a simulation status can be defined. Simulation can be switched on or off (1 = ON, 0 = 
OFF). 

 

CAUTION  
The simulation must be manually switched off. The simulation is terminated when the 
device is switched off and on. 

 
 

PVScale  

Based on the measured value of the flow rate (see Transducer Block), the relative value is 
calculated first. PVScale parameter (consisting of 100% = URV, 0% = LRV, unit of the 
measured value (PVScale))  

(Q in %) =  
(meas.value Q) – PVScale

 
0% PVScale100% – PVScale0%  

The measured value unit must be identical to the unit of the Transducer Block; measured 
value, URV and LRV e.g. in l/h 

In this block parameters that relate to the recording of the measuring value of the MEM-PPA 
are summarized. 

OUTScale 

In the next step the absolute value of the output is calculated on the relative value. 
OUTScale parameter (consisting of 100% = URV = end value, 0% = LRV = beginning value, 
output unit): 

OUT = (Q in %) · (OUTScale 100% - OUTScale0%) + OUTScale0% 

The units of the Parameter block OUTScale are identical to the Transducer Block/Measuring 
unit.  

HI-LIM / HI-ALM (upper warning limit) 

If the limit is exceeded, a warning is issued. 

HI-HI- LIM / HI-HI-ALM (upper alarm limit) 

If the limit is exceeded, an alarm is issued. 

LO-LIM / LO-ALM (lower warning limit) 

If the measured value falls below this limit, a warning is issued. 

LO-LO- LIM / LO-LO-ALM (lower alarm limit) 

If the measured value falls below this limit, an alarm is issued. 

Hysteresis 

The hysteresis of the limit values has a one-sided effect. 
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OUT 

Here the value "OUT" can be read acyclically. 

Factory Reset (acyclic communication) 

The "factory reset" command resets several parameters to their default values. 

● Device address: 126 

● Filter time constant: 3 seconds 

● Low-flow cutoff: 0 

● Reset of TAG, Descriptor, Date 

A factory reset causes a reset of the parameter blocks PVScale, OUTScale and Limit values 
to the basic unit m³/h. 

Maintenance 

The MEM-PPA is maintenance-free. In case of a malfunction the MEM-PPA can be 
replaced. A malfunction has, for example, occurred when the output current supplied by the 
device differs considerably from the expected value (e.g. difference cannot be explained with 
a temperature drift). 

If there is a justified doubt about the operation of the device, the device must be returned to 
the manufacturer. The device must not be repaired by the user. 
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7Service and maintenance 

7.1 Maintenance 
The device is maintenance-free, however, a periodic inspection according pertinent 
directives and regulations must be carried out.   

An inspection can include check of: 

● Ambient conditions 

● Seal integrity of the process connections, cable entries, and cover screws 

● Reliability of power supply, lightning protection, and grounds 

Instrument cleaning 
During the setting into operation of new systems, residual materials are conveyed in the 
medium and could adhere to the variable area meter. In this case we recommend cleaning 
the instrument after a short period of operation. In particular ferromagnetic substances such 
as weld beads could lead to the shut-down of the equipment. A magnet filter (accessory) 
should be mounted in front of the instrument if such fragments cannot be avoided in routine 
operation.  

7.2 Unit cleaning 
Depending on the measuring substances, contamination, abrasion or chemical reactions 
could affect the measuring orifice and the float and hence have an impact on the measuring 
accuracy. In this case the instrument should be dismounted and cleaned with suitable agents 
including the rotameter.  

 

CAUTION  
Aggressive cleaning agents 

Do not damage the device mechanically by hard objects or by aggressive cleaning agents. 
 

WARNING  
Device corrosion 

If attacks are detected on the measuring orifice or the float, they must be recalibrated or 
replaced. 
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Observe the following points:  

● In instruments with installed electrical equipment, the removal of the display hood will 
lead to constraint in the EMC protection. 

● Before you dismount an instrument, ensure that the pipeline is free from process media 
and pressure and has cooled down. 

● Fittings that are coated on the inside can be cleaned carefully following disassembly 
using a brush and appropriate cleaning agents. The rotameter should be carefully 
cleaned to remove coating. 

Switching point adjustment 
The switching points of the limiting value transmitters are adjustable.  

● Remove the display hood, loosen the contact point pointers on the scale and re-set. 

● Tighten the screws of the contact point pointers after adjustment. 

● Replace the display hood and fix tightly. 

The parameterization of the MEM may be carried out using "Commissioning with PDM" 
(Page 35). 
 

Check cylinders and gas fluid dampers for contamination (see "Dismounting/Installation of 
dampers" (Page 22)).  

On conclusion of the maintenance and cleaning work the instruments must be subjected to a 
function control before being put back into operation. 

7.3 Recalibration 
Siemens A/S Flow Instruments offers to recalibrate the sensor. The following calibration is 
offered as standard:  

● Standard matched pair calibration 

 

 Note 

For recalibration the memory unit must always be returned with the sensor. 

7.4 Unit repair 
 

NOTICE  
Repair and service must be carried out by Siemens authorized personnel only. 

 

 Note 

Siemens defines flow sensors as non-repairable products.    
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7.5 Technical support 
If you have any technical questions about the device described in these Operating 
Instructions and do not find the right answers, you can contact Customer Support:  

● Via the Internet using the Support Request:  

Local contact 
person http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&
objid=16604318&caller=view 
(http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=
16604318&caller=view)  

● Via Phone: 

– Europe: +49 (0)911 895 7222 

– America: +1 423 262 5710 

– Asia-Pacific: +86 10 6475 7575 

Further information about our technical support is available on the Internet at  
 Support request (http://www.siemens.com/automation/support-request)  

Service & Support on the Internet  
In addition to our documentation, we offer a comprehensive knowledge base online on the 
Internet at:  

Service and support (http://www.siemens.com/automation/service&support)  

There you will find: 

● The latest product information, FAQs, downloads, tips and tricks. 

● Our newsletter, providing you with the latest information about your products. 

● Our bulletin board, where users and specialists share their knowledge worldwide. 

● You can find your local contact partner for Industry Automation and Drives Technologies 
in our partner database. 

● Information about field service, repairs, spare parts and lots more under "Services." 

Additional Support  
Please contact your local Siemens representative and offices if you have additional 
questions about the device. 

Find your local contact partner at: http://www.automation.siemens.com/partner 
(http://www.automation.siemens.com/partner)  

7.6 Return procedures 
Enclose the delivery note, the cover note for return delivery and the declaration of 
decontamination form on the outside of the package in a well-fastened clear document 
pouch.    

http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=16604318&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=16604318&caller=view
http://www.siemens.com/automation/support-request
http://www.siemens.com/automation/service&support
http://www.automation.siemens.com/partner
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Required forms 
● Delivery Note 

● Cover Note for Return Delivery with the following information 

Cover note 
(http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=
16604370&caller=view)  

– product (ordering number) 

– number of devices or spare parts returned 

– reason for the return 

● Declaration of Decontamination  

Declaration of Decontamination 
(http://www.automation.siemens.com/w1/efiles/feldg/files/Service/declaration_of_deconta
mination_en.pdf)  

With this declaration you certify that the returned products/spare parts have been 
carefully cleaned and are free from any residues. 
If the device has been operated together with toxic, caustic, flammable or water-
damaging products, clean the device before return by rinsing or neutralizing. Ensure that 
all cavities are free from dangerous substances. Then, double-check the device to ensure 
the cleaning is completed. 

We shall not service a device or spare part unless the declaration of decontamination 
confirms proper decontamination of the device or spare part. Shipments without a 
declaration of decontamination shall be cleaned professionally at your expense before 
further proceeding.  

You can find the forms on the Internet and on the CD delivered with the device. 

http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=16604370&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=16604370&caller=view
http://www.automation.siemens.com/w1/efiles/feldg/files/Service/declaration_of_decontamination_en.pdf
http://www.automation.siemens.com/w1/efiles/feldg/files/Service/declaration_of_decontamination_en.pdf
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Table 8- 1 General data 

Range of application Flow measurement of liquids and gases 
Measuring principle Flotation / Float measuring 
Orientation Vertical - flow direction from bottom to top 

Table 8- 2 Measuring accuracy 

Directive VDI / VDE 3513, sheet 2 (qG = 50%) 
Liquids G 1.6 (add. 0.2%* of URV for MEM / MEM-PPA) 
Gases G 2.5 (add. 0.2%* of URV for MEM / MEM-PPA) 
Reproducibility 0.5% of URV (add. 0.1% of URV for MEM / MEM-PPA) 

* Additional error in the event of temperature deviations from the reference conditions of the 
calibration process. 

Table 8- 3 Materials 

 Type CF-S Type EF-H Type FF-P 
Wetted parts Stainless steel Hastelloy® PTFE 

⇐ DN 25 (1") Hastelloy®** Flange 
Hastelloy® stainless* 

Stainless steel* Stainless steel* 
> DN 25 (1") 
⇐ DN 25 (1") Hastelloy®** Fitting Stainless steel* 
> DN 25 (1") Hastelloy® stainless* 

Stainless steel with 
PTFE liner 

Float / Guide bracket Stainless steel* Hastelloy®** PTFE 
Display unit Aluminium (optional stainless steel) with safety glass pane 

* Stainless steel (1.4404 / 1.4571) 

** Hastelloy 24610 

Table 8- 4 Operating conditions - all devices 

Temperature  
Type CF-S Type EF-H Type FF-P  

Max. medium temp. TS -20 ... +200 °C (-4 ... +392 °F) 
-80 ... +300 °C (-112 ... +572 °F) 

-20 ... +125 °C (-4 ... +257 °F) 

Pressure (see chapter 8.2) 
 Type CF-S Type EF-H Type FF-P 

DN 15 - DN 
100 

PN 160 (optional up to 400 bar) Max. medium 
pressure PS 

½" - 4" 580 psi (optional up to 5800 psi) 
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Min. operating pressure > 2 x pressure loss (see measuring ranges) 
Climate classification Weatherproof and/or non-heated locations 

Class C in accordance with DIN IEC 654 Section 1 
Protection class (DIN EN 60529) 
Display unit Aluminum: IP65 

Stainless steel: IP66 

 

Table 8- 5 Temperatures 

Device version Ambient temperature* Storage temperature 
Without electrical 
components 

-40 ... +80 °C (-40 ... +176 °F) -40 ... +80 °C (-40 ... +176 °F) 

With limit switch (es) -40 ... +65 °C (-40 ... +149 °F) -40 ... +65 °C (-40 ... +149 °F) 
With 4 ... 20 mA output -40 ... +70 °C (-40 ... +158 °F) -40 ... +70 °C (-40 ... +158 °F) 

*IMPORTANT! 
 

 Note 
Hazardous areas 

For applications in hazardous areas it is mandatory to observe the temperature class of the 
type examination certificate (protection type). 

For devices used in hazardous areas, additional safety notes apply; see "Installation in 
hazardous area" (Page 11). 

 

8.1 Classification according to pressure equipment directive (PED 
97/23/EC) 

 
Process connection 

EN 1092-1 ANSI B16.5 

Permissible media Category 

DN 15 ½" Gases and fluids of fluid group 1 Article 3.3 
DN 20 ¾" Gases and fluids of fluid group 1 Article 3.3 
DN 25 1" Gases and fluids of fluid group 1 Article 3.3 
DN 32 1¼" Gases and fluids of fluid group 1 III 
DN 40 1½" Gases and fluids of fluid group 1 III 
DN 50 2" Gases and fluids of fluid group 1 III 
DN 65 2½" Gases and fluids of fluid group 1 III 
DN 80 3" Gases and fluids of fluid group 1 III 
DN 100 4" Gases and fluids of fluid group 1 III 
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8.2 Pressure vs. temperature (stainless steel) 

 

8.3 Limit switches 
 
Switching principle Inductive contact, single contact and twin 

contact, NAMUR NC 
Connection M20x1.5 
Auxiliary power supply 8 V DC, Ri approx. 1 kOhm 
Self-inductance 250 μH 
Self-capacitance 50 nF 
Ambient temperature  

-40 ... +65 °C (-40 ... +149 °F) 
II 2G EEx ia IIC T6 

 When used in non-hazardous locations 
 Explosion protection 
 EC-Type Examination Certificate for Directive 

94/9/EC 
PTB 99 ATEX 2219 X 

Isolation (2 contacts) Galvanically isolated 
Terminal connection 2.5 mm2 
Limit switch SJ 3.5-N 
Supply voltage 5 ... 25 V DC 
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8.4 MEM Transducer HART with 4-20 mA 
 
Electric remote transmitter, signal output HART 
Connection 2-wire 
Auxiliary power supply 14 ... 30 V DC 
Output 4 ... 20 mA 
Ambient temperature 
 When used in non-hazardous locations 

 
-40 ... +70 °C (-40 ... +158 °F) 

Explosion protection II 2G EEx ia IIC T6 
EC-Type Examination Certificate for 
Directive 94/9/EG 

BVS 07 ATEX E 033 

Measuring accuracy  
< ±0.2 % of URV  In the supporting structure 
< ±0.1 % of measured value  Influence of power supply 

 Influence of load (0.2 ... 680Ω) 
 Influence of ambient temperature 

< ±0.1 % of measured value 
< ±0.5 % of URV/10°K 

Reproducibility Typically < 0.1% of URV 
Resolution Typically 0.05 % of URV 
Conformity  

 EN 61000-6-2;1999 Electromagnetic compatibility (EMC) 

 EN 50081-1 
 EN 55011:1998+A1:1999 Group1, Class B 
 NAMUR NE21 

Electrical connection terminals 2.5 mm² 
Load Max. load RB is dependent on power supply: 

RB =  UB – 14V 
22mA  

RB < 250 Ω on application of the HART protocol 

8.5 MEM transducer HART with additional pulse output and limit 
switches 

 
Binary outputs 
Switching principle NAMUR switch in accordance with EN 60947-6-6:2000 
Number 2 
Control state 
 open 
 closed 

 
Typically 0.4 mA 
Typically 4.0 mA 
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Function Limit signal transducer or pulse output 
Explosion protection II 2G EEX ia IIC T6 (-40 ... +70 °C [-40 ... +158 °F]) 

Ui = 30 V DC 
Ii = 20 mA 
Pi = 100 mW 
Li = 4 μH 
Ci = 16 nF 
BVS 07 ATEX E 033 

8.6 MEM transducer PROFIBUS PA 
 
Electric remote transmitter, signal output PROFIBUS PA 
Connection 2-wire 
Auxiliary power supply 10 ... 25 V DC 
Basic current < 16.5 mA 
Fault current < 18 mA 
Transfer rate 31.25 kBaud 
Ambient temperature 
 When used in non-hazardous locations 

 
-40 ... +70 °C (-40 ... +158 °F) 

Explosion protection II 2G EEx ia IIC T6 
EC-Type Examination Certificate for Directive 94/9/EC BVS 07 ATEX E033 
Accuracy 
 In the interpolation points 
 Influence of power supply 
 Influence of ambient temperature 

 
< ±0.2% of URV 
<0.1 % of measured value 
< ±0.5 % of URV/10°K 

Reproducibility Typically < 0.1 % of URV 
Resolution Typically 0.05 % of URV 
Conformity 
Electromagnetic compatibility (EMC) 

 
 EN 61000-6-2:1999 
 EN 50081-1 
 EN 55011:1998+A1:1999 

Group1, Class B 
 NAMUR NE21 

Safety data EEX ia IIc T6 
(-40 ... +70 °C [-40 ... + 158 °F]) 
Ui = 25 V DC 
Ii = 280 mA 
Pi = 2 W 
Li < 10 μH 
Ci < 5 nF 
BVS 07 ATEX E033 
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Dimensions and weight 9
 

 
Figure 9-1 SITRANS FVA250, Standard version (aluminum display housing) 

Table 9- 1 Dimensions in mm (inch), SITRANS FVA250 standard version 

DN PN I. W. A Weight [kg (lbs)] 
15 (½") 40 (150 lbs) 26 (1.02) 74 (2.91) 3.0 (6.6) 
20 (¾") 40 (150 lbs) 26 (1.02) 74 (2.91) 3.0 (6.6) 
25 (1") 40 (150 lbs) 32 (1.26) 77 (3.03) 4.2 (9.3) 
32 (1 ¼") 40 (150 lbs) 32 (1.26) 77 (3.03) 5.2 (11.5) 
40 (1 ½") 40 (150 lbs) 46 (1.81) 88 (3.46) 6.0 (13.2) 
50 (2") 40 (150 lbs) 70 (2.76) 97 (3.82) 7.5 (16.5) 
65 (2 ½") 16 (150 lbs) 70 (2.76) 97 (3.82) 8.5 (18.7) 
80 (3") 16 (150 lbs) 102 (4.02) 113 (4.45) 13 (28.7) 
100 (4") 16 (150 lbs) 125 (4.92) 126 (4.96) 18 (39.7) 

* +100 mm with displaced display 
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Heating jacket version 

 
Figure 9-2 SITRANS FVA250, Heating jacket version 

Table 9- 2 Dimensions in mm (inch), heating jacket version  

DN B flange S Weight [kg (lbs)] 
15 (½") 110 (4.33) 150 (5.91) 4.7 (10.4) 
20 (¾") 110 (4.33) 150 (5.91) 4.7 (10.4) 
25 (1") 110 (4.33) 150 (5.91) 5.9 (13.0) 
32 (1 ¼") 110 (4.33) 150 (5.91) 6.9 (15.2) 
40 (1 ½") 130 (5.12) 150 (5.91) 7.8 (17.2) 
50 (2") 140 (5.51) 150 (5.91) 9.6 (21.1) 
65 (2 ½") 140 (5.51) 150 (5.91) 11.0 (24.2) 
80 (3") 160 (6.3) 150 (5.91) 16.0 (35.2) 
100 (4") 175 (6.89) 120 (4.72) 22.0 (48.4) 

* + 100 mm with displaced display 



 Dimensions and weight 
  

SITRANS FVA250 
Operating Instructions, 02/2013, A5E03821131-01 59 

Stainless steel version 

 
Figure 9-3 SITRANS FVA250, Stainless steel version (stainless steel display housing) 

Table 9- 3 Dimensions in mm (inch), stainless steel version  

DN PN I. W. A Weight [kg (lbs)] 
15 (½") 40 (150 lbs) 26 (1.02) 103 (4.06) 3.1 (6.8) 
20 (¾") 40 (150 lbs) 26 (1.02) 103 (4.06) 3.1 (6.8) 
25 (1") 40 (150 lbs) 32 (1.26) 105 (4.13) 4.3 (9.5) 
32 (1 ¼") 40 (150 lbs) 32 (1.26) 105 (4.13) 5.3 (11.7) 
40 (1 ½") 40 (150 lbs) 46 (1.81) 115 (4.53) 6.1 (13.4) 
50 (2") 40 (150 lbs) 70 (2.76) 129 (5.08) 7.6 (16.7) 
65 (2 ½) 16 (150 lbs) 70 (2.76) 129 (5.08) 8.6 (18.9) 
80 (3") 16 (150 lbs) 102 (4.02) 145 (5.71) 13.1 (28.9) 
100 (4") 16 (150 lbs) 125 (4.92) 158 (6.22) 18.1 (39.9) 

* +100 mm with displaced display 
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